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General Safety Summary

Review the following safety precautions carefully before operate the device to avoid any
personal injuries or damages to the device and any products connected to it.
To avoid potential hazards use the device as specified by this user’s guide only.

m To Avoid Fire or Personal Injury

m Use Proper Power Cord. Use only the power cord specified for this product and certified
for the country of use.

m Connect and Disconnect Properly. Do not connect or disconnect probes or test leads
while they are connected to a voltage source.

m Connect and Disconnect Properly. Connect the probe output to the measurement
device before connecting the probe to the circuit under test. Disconnect the probe input
and the probe reference lead from the circuit under test before disconnecting the probe
from the measurement device.

m Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings and
markings on the product. Consult the product manual for further ratings information before
making connections to the product.

m Use Proper Probe. To avoid shock hazard, use a properly rated probe for your
measurement.

m Avoid Circuit or Wire Exposure. Do not touch exposed connections and components
when power is on.

m Do Not Operate With Suspected Failures. If suspected damage occurs with the device,
have it inspected by qualified service personnel before further operations.

m Provide Proper Ventilation. Refer to the installation instructions for proper ventilation of
the device.

m Do not operate in Wet/Damp Conditions.
m Do not operate in an Explosive Atmosphere.

m Keep Product Surfaces Clean and Dry.
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Chapter 1 Getting Start

The oscilloscope is small, lightweight, no external power required, portable oscilloscopes!
The oscilloscopes is ideal for production test, research and design and all of the
applications involving analog circuits test and troubleshooting, as well as education and
training.

In addition to the list of general features on the next page, this chapter describes how to do
the following tasks:

€ System Requirements
Install Software
Install Driver

General Features
General Check
Function Check

Self Calibration

® & 6 ¢ ¢ o o

Accessories
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1.1 System Requirement

To run the oscilloscope software, the needs of computer configuration are as follows:
Minimum System Requirements

Operating System
Window XP/Vista/Win7

Processor
Upwards of 1.00G processor

Memory
256M byte

Disk Space
500M disk free space

Screen resolution
800 x 600

Recommended Configuration

Operating System
Windows XP SP3 System

Processor
2.4G Processor

Memory
1G Byte Memory

Disk Space
80G Disk Space

Screen resolution
1024 x 768 or 1280 x 1024 resolution

DPI Setting
Normal Size (96DPI)
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1.2 Install Software

Caution: You must install the software before using the oscilloscope.
1. While in Windows, insert the installation CD into the CD-ROM drive.

2. The installation should start up automatically. Otherwise in Windows Explorer, switch
to the CD-ROM drive and run Setup.exe.

3. The software Installation is started. Click 'Next' to continue.

Welcome to DS0BO000 Yerl. 0.1 Setup program. This
program will install DS0G000 Verl 0.1 on your
compuater.

It 1= strongly recommended that wou exit all
Windows programs before running thisz Setup Frogram.

Click Cancel to gquit Setup and clese any programs
wou hawe running. Click Hext to continme with the
Setup program.

WARHTHG: This program is protected by copyright law
and international treaties.

Unaunthorized reproduction or distribution of this
program, of any portion of 1t, may result in sewvere
civil and criminal penalties, and will be
prosecuted to the maximum extent possible under
Law.

4. Choose a destination directory. Click ‘'Next' to continue.

Select Destination Directory

Setup wi1ll install DSOG000 Yerl. 0.1 in the following folder.

To 1nstall into a different folder, click Browse, and szelect another
folder.

You can choose not te install DSOBO00 Werl. 0.1 by clicking Cancel to
exit Setup.

’*Deztination Folder

C:%"Program FileshDSOG000 Browse. . . |

Wize Installation

< Back Hext Cancel |
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5.

6.

7.

Check the setup information. Click Next to start copying of files.

“E) DSO6000 Verl.

Start Installation

Tou are now ready to install DS0B000 Werl. 0. 1.

Click the Hext button to begin the installation or the Back butten ta
reenter the installation information

Wize Installation

< Back i Hext » : Cancel |

This Status dialog is displayed during copying of files.

DSO6000 Ver

Installing

L7

2 a

Copving file:
C:'"Frogram FileshDSOG000%Aut o' fmhaM_SENSORS _ARS 1. amr

#11 Files

Current File

Time Bemaining 0 minutez 1 second

SEEEENEEEEEEEEEEEEEEEE
tise THMSF

| Cancel |

Updating Your System Configuration.

% |pdating System Configuration, Pleaze YW ait. .
g

8. The installation is complete.
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DSOB000 Verl.0.1 has been successfully installed.

Click the Finish button to exit this installation.

1.3 Install Driver

Example: HANTEK 6000B
1.Connect the A-Type Plug of USB cable to your PC’S USB port.

2.Connect the other A -Type Plug of USB cable to the device’s USB port.

3.New hardware is found.

Installing device driver software % *
Click here for status.

4.Click right mouse and select “Manage”.

“[l. Device driver software was not successfully installed * *
Click here for details.
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Open
Manage

Map network drive...

Disconnect network drive...

Create shortcut
Delete

Rename

Properties

le Action View Help

@ f

& Computer Management (Local|| 4 2 hantek-PC

4 [} System Tools /8 Computer

| > () Task Scheduler g Disk drives

> (8] Event Viewer K, Display adapters

> @] Shared Folders & DVD/CD-ROM drives

> & Local Users and Groups < Floppy disk drives

| > (8) Performance = Floppy drive controllers
= Device Manager 8% Human Interface Devices

4 Storage L IDE ATA/ATAPI controllers

(2 Disk Management 2 Keyboards
> Ty Services and Applications Bl Mice and other pointing devices
K| Monitors

& Network adapters
|l Other devices
[lin DSO Device
& Portzble Devices
Y3 Ports (COM & LPT)
3 Processors
| Sound, video and game controllers
78 System devices
> § Universal Serial Bus controllers

AT YT T YTV YOV VT T

Actions
Device Manager -
More Actions 3

5.Click right mouse and select “Update Driver Software”.
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File Action View Help

o8| H

0] %0

;{l Computer Management (Local)
4 [?é System Tools
b @ Task Scheduler
i & Event Viewer
I @l Shared Folders
2 ,\_-El Local Users and Groups
b @ Performance
= Device Manager
4 23 Storage
= Disk Management
[ ig Services and Applications

4= hantek-PC
14 Computer
I g Disk drives
- B, Display adapters
s ey DVD/CD-ROM drives
1_5," Floppy disk drives

L—E Floppy drive controllers
L5 Human Interface Devices
- IDE ATA/ATAPI controllers
2= Keyboards

--8 Mice and other pointing devices
‘A Monitors

¥ Network adapters

|l5) Other devices

Actions

Device Manager -
Mare Actions

i || DSO Devir=-|
|‘> EI¥ Portable Devi Update Driver Software...
» I Ports (COM Disable
b 2 Processors Uninstall
b -3 Sound, video)
> -JM System devig Scan for hardware changes
[ a Universal Seri
Properties

Launches the Update Driver Software Wizard for the selected device.

IS

6.Select “Browse my computer for driver software”.

-

t\;—) U Update Driver Software - DSO Device
-

[ settings.

How do you want to search for driver software?

< Search automatically for updated driver software
L Windows will search your computer and the Internet for the latest driver software
for your device, unless you've disabled this feature in your device installation

= Browse my computer for driver software
Locate and install driver software manually.

Cancel

-

7.Select the right driver path, click “Next”.
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[ L A L] ==

@ [l Update Driver Software - Hantek 300K
-

Browse for driver software on your computer

Search for driver software in this location:

I C:\Program Files\HantelkX3000Driver - Browse...

| [V] Include subfolders

= Let me pick from a list of device drivers on my computer

This list will show installed driver software compatible with the device, and all driver
software in the same category as the device,

[ Mext ][ Cancel ]
EE

8.Click “Install this driver software anyway”.

-
Windows Security M

Cg] Windows can't verify the publisher of this driver software

= Don'tinstall this driver software
You should check your manufacturer's website for updated driver software
for your device.

= Install this driver software anyway
Only install driver software obtained from your manufacturer's website or
disc. Unsigned software from other sources may harm your computer or steal
information.

(w) See details

9.Installing driver software...
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[ —-mg
. — - - .
() L Update Driver Software= DSO Device -

— —

Installing driver software...

10.Hantekxxxx USB has been successfully installed.

) L Update Driver Software - Hantek6000B
Windows has successfully updated your driver software |

Windows has finished installing the driver software for this device:

:. Hantek6000B
-

=

= =

11.After the device driver is installed correctly, the device manager is shown as
follows
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File Action View Help

as|n

| B %S

=)

;&7 Computer Management (Local)
a4 m Systemn Tools
3 @ Task Scheduler
i {2 Event Viewer
I> @& Shared Folders
[ %l Lacal Users and Groups
b @ Performance
=4 Device Manager
a4 {S Storage
= Disk Management
[ _-?5; Services and Applications

4= hantek-PC
-8 Computer
=] Disk drives
» -, Display adapters
> e DVD/CD-ROM drives
> I_Jhl Floppy disk drives

B L—El Floppy drive controllers

-E¥ Hanteks000B

- @ Hantek6000E |

» l:ﬁ Human Interface Devices

b g IDE ATA/ATAPT controllers
- Keyboards

> --B Mice and other pointing devices
» - Monitors

» - Network adapters

» - Portable Devices

- Y7 Ports (COM & LPT)

[ n Processors

| Sound, video and game controllers
&M System devices

5§ Universal Serial Bus controllers

Actions
Device Manager -
More Actions »
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1.4 General Features

Product Features:

m Four Channels, Max Bandwidth:
250MHz/200MHz/100MHz/70MHz

m Maximum real-time sample rate:
1GSal/s

m Memory depth:
64K /CH
m Automatic setup for ease of use (AUTOSET);

m Built-in Fast Fourier Transform function(FFT);

m 20 Automatic measurements;

m Automatic cursor tracking measurements;

m Waveform storage, record and replay dynamic waveforms;

m User selectable fast offset calibration;

m Add, Subtract and Multiply Mathematic Functions;

m Selectable 20 MHz bandwidth limit;

m Waveform average;

m Adjustable waveform intensity, more effective waveform view;

m User interface in several user-selectable languages;

USER'S MANUAL 14
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1.5 General Check

Please check the instrument as following steps after receiving an oscilloscope:

Check the shipping container for damage:

Keep the damaged shipping container or cushioning material until the contents of the
shipment have been checked for completeness and the instrument has been checked
mechanically and electrically.

Check the accessories:
Accessories supplied with the instrument are listed in "Accessories" in this guide. If the
contents are incomplete or damaged, please notify the franchiser.

Check the instrument:
In case there is any mechanical damage or defect, or the instrument does not operate
properly or fails performance tests, please notify the franchiser.

Probe Compensation

Perform this function to match the characteristics of the probe and the channel input.
This should be performed whenever attaching a probe to any input channel at the first
time.

m From the “Probe” menu, select attenuation to 1:10. Set the switch to “X10” on the probe
and connect it to CH1 of the oscilloscope. When using the probe hook-tip, insert the tip
onto the probe firmly to ensure a proper connection.

m Attach the probe tip to the Probe Compensator and the reference lead to the ground
connector, select CH1, and then press the “AUTOSET*“ button into the menu or the
toolbar.

m Check the shape of the displayed waveform.

Correctly Compensated

USER'S MANUAL 15
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—

Over Compensated

Under Compensated

1. If necessary, use a non-metallic tool to adjust the trimmer capacitor of the probe for the
fattest square wave being displayed on the oscilloscope.
2. Repeat if necessary.

WARNNING: To avoid electric shock while using the probe, be sure the perfection of the
insulated cable, and do not touch the metallic portions of the probe head while it is
connected with a voltage source.

USER'S MANUAL 16
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1.6 Function Check

Perform this functional check to verify that your oscilloscope is operating correctly.

m Connect the oscilloscope
You should connect the A-Type Plug of USB cable to your PC USB port and connect the
other A-Type Plug of USB cable to oscilloscope USB port.

m Input a signal to a channel of the oscilloscope
The oscilloscope is equipped with two channels plus external trigger.

Please input signal in the following steps:

1. Set the attenuation switch on the probe as 10X and connect the probe on the
oscilloscope with CH1. Aim the slot in the probe connector at the faucet on BNC of CH1
and insert, then, turn right to lock the probe. Finally, attach the tip of probe and ground nip
to the Connector of Probe compensator.

2. Set the CH1 probe attenuation of the oscilloscope to X10. (The default is X1).

USER’'S MANUAL 17
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3. Attach the tip of probe and ground nip to the Connector of Probe compensator. Click the

@ button. A square wave will be displayed within a several seconds. (Approximately 1
kHz, 2V, peak- to- peak).

4. Inspect CH2 with the same method. Repeat steps 2 and 3.

1.7 Self Calibration

The self calibration routine lets you optimize the oscilloscope signal path for maximum
measurement accuracy. You can run the routine at any time but you should always run
the routine if the ambient temperature changes by 5v or more. For accurate calibration,
power on the oscilloscope and wait twenty minutes to ensure it is warmed up. To
compensate the signal path, disconnect any probes or cables from the input connectors.
Then, access the “Utility -> Calibration” option and follow the directions on the screen.
The self calibration routine takes about several minutes.

USER'S MANUAL 18
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1.8 Accessories

All the accessories listed below are standard accessories for the oscilloscope:
HANTEK 6000BC:

@ Probe x 2 (1.5m), 1:1(10:1), Passive Probes
€ A USB cable

€ QuickGuide

@ A software installation CD

HANTEK 6000BD:

€ Probe x 2 (1.5m), 1:1(10:1), Passive Probes
€ A USB cable

€ QuickGuide

@ A software installation CD

4 ABNCTOBNC

HANTEK 6000BE:

@ Probe x 2 (1.5m), 1:1(10:1), Passive Probes
€ A USB cable

@ QuickGuide

€ A software installation CD

€ AHT25
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Chapter 2 Operating Basics

€ The User’s Interface

€ The Menu System

€ The Vertical System

€ The Horizontal System
€®The Trigger System

€ Input Connectors

USER'S MANUAL 20
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2.1 The User’s Interface

Click the software icon on the desk after you finished the software setting and equipment
connecting. Then a user interface will be showed as follows:

DSO-6000 - [Scopel] 1 oo e

||FHe View Setup Display Cursor Measure Acquire Utility Vehicle Window He\pl

Connect: O DDS: .

DSO || pDs

Horizontal

Time / DIV

[1.000ms ~| LI ¢

Format

-1 ~|

Vertical

|CH4 ,l | ON/OFF

s00v = 3 5
——

[ac |

|x1 v|

Trigger

Trigger Mode |Edge v|

Trigger Sweep |AUTO v| 7
e

Trigger Source |CH1 v|

Trigger Slope ‘+ v|

04-01-2016 13:4¢
i /

T
8

In addition to displaying waveforms, the display area is filled with many details about the
waveform and the oscilloscope control settings.
1. The Main Menu: All settings can be found in the main menu.

2. The Toolbar

3. Displays the trigger information: Displays the edge trigger slope, source and level.

4. The DDS Panel (HANTEK 6000BD)

5. The Horizontal Panel: The user can change Time/Div, format in the panel.

6. The Vertical Panel: The user can turn on/off the CH1/CH2/CH3/CH4. Also the user
can change the CH1/ CH2/CH3/CHA4 volt/div, coupling and probe attenuation.

7. The Trigger Panel: In this panel, the user can change the trigger mode, sweep, source
and slope.

8. Displays the system time.

9. Marker shows Edge trigger level

10. Displays the main time base setting.
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11. Displays the CH1/CH2/CH3/CH4 information:
Readouts show the coupling of the channels.
Readouts show the vertical scale factors of the channels.
A “B” icon indicates that the channel is bandwidth limited
12. Connect
13. The markers show the CH1/CH2/CH3/CH4 reference points of the displayed
waveforms. If there is no marker,the channel is not displayed.
14. Marker shows horizontal trigger position
15. Trigger status indicates the following:
AUTO: The oscilloscope is in auto mode and is acquiring waveforms in the absence of
triggers.
Trig’'D: The oscilloscope has seen a trigger and is acquiring the post trigger data.
STOP: The oscilloscope has stopped acquiring waveform data.

RUN: The oscilloscope is running.

2.2 The Menu System

The Main Menu:
File WView Setup Display Cursor Measure Acquire Wtility Wehicle Windew Help

1.File: Load or Save data, setup

‘I.I’iew Setup Display Cur

MNew Ctrl+MN
Close

Load Data Ctrl+L
Load Setup

Save Data Ctrl+5S
Save Setup

Save Image

Print... Ctrl+P
Print Preview

Print Option

Exit
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2.View: Change the user interface

v Toolbar
v Status Bar
v Side Bar

3.Setup: Setup setting

EEF Ctrl+R
MATH Ctrl+h

Trigger Ctrl+T
Yertical Citrl+V¥
Horizontal Ctirl+H

4.Display: Change wave display type

Display | Cursor Measure Acquire  Utilit

Type 3
v | Grid Ctrl+G

Intensity

Grid Background Color

5.Cursor: Set Cursor measure type

A Meas

Source F

Type 4

6. Measure: Set measurement parameters

Soarce L
Vertical L
Horizontal L

Clear Measzure

Edit Measzure

7.Acquire: Run ,Stop or other operation setting
[Acquire | Utility Window Help
v Run Ctrl+R
Stop Ctrl+0

foom Qut

Zoom In
Buffer Length b
Acquisition »

Interpolation r

Autoset
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8. Utility: Utility setting
Pass/Fail
FfC »

Calibration
Factory Setup

Language »

9.Vehicle:

Diagnosiz Setup

Clear reference waveform
10. Window: Window setting

Hindow [CAE

Cazcade
Vertical
Horizontal

Arrange Icons

v 1 Scopel

11.Help: Turn on help file

Contents F1
Abcut. .. FO

1.3 The Vertical System

Click “Setup->Vertical”

The following figure shows the vertical Setup window. It shows the vertical parameters

setting.
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¥ertaical Setup

Select Channel

Channel Zetting

Coupling | AC

Prabe | =1

By Limit

OMICFF

WOLTS PO | 1.00% -

%]

W

[Tirvert

Cancel

d

1.Select channel: User can select the channel by clicking the Combo box.

3.VOLTS/DIV: Set the selected channel voltage range.

WOLTS DR |1 .00 —

4.Coupling: Set the selected channel to DC/AC.

Coupling | AC r\:
Dz

5.Probe: Set the Select one according to the probe attenuation factor to ensure correct

vertical scale reading

6.BW Limit: Reject the frequency component higher than 20MHz.

USER'S MANUAL
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7.Invert: Invert the selected wave.

[ Tirvert

2.4 The Horizontal System

Click “Setup->Horizontal”

The following figure shows the Horizontal System window. It shows the horizontal

parameters settings.

Horizontal Setup

Setting
Time fDY 20004z  »
Format |[% -T w
% - T Format
{E} Mormal {:} Scan {:} Foall
® - Setting
¥ - Cootdinate Y - Coordinste

1. Time/DIV: leads the setting of the time base parameters

Time fDY 50004z »

2. Format: leads the setting of the horizontal format parameters

Format [ -T W

2.5 The Trigger System

Click “Setup-> Trigger”

The following figure shows the trigger system control.

USER'S MANUAL
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Trigger Setup |t S|

Setting

Trigger Mode | Edge -

Trigger Sweep | AUTO -

Trigger Source |CH1 -

Trigger Slope |+

["] HF Rejection

Trigger:

1.Trigger Mode: Sets the trigger mode

2.Trigger Sweep: Selects the trigger sweep mode to AUTO, NORMAL or SINGLE
3.Trigger Source: Selects the trigger source to CH1, CH2, CH3, CH4

4.Trigger Slope: Selects the edge trigger slope to Positive or Negative slope

2.6 Input Connector

CH1/CH2/CH3/CH4: Input connectors for waveform display.

Other Connector:
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GND.: A ground terminal
USB PORT: Connect the USB cable to this port.

CAL.: Probe compensation output.
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Chapter 3 Oscilloscope Functions

#Set Oscilloscope

®Set Vertical System

# Set Horizontal System

@ Set Trigger System
®Save/Load

@ Utility Function

¥ Measure Signal

€®Zoom In/Out Waveforms
®Acquire Signal

®Print
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3.1 Setup the Oscilloscope

Using “AUTOSET” to display a signal automatically.

Auto setup functions one time each time you push the “AUTOSET” button. The function
obtains a stable waveform display for you. It automatically adjusts the vertical scale,
horizontal scale and trigger settings. Auto setup also displays several automatic

measurements in the graticule area, depending on the signal type.
Connect a signal to the CH1 input:

1. Connect a signal to the oscilloscope as described above.

2. Click the “Acquire -> Autoset” button.

The oscilloscope will change the current settings to display this signal.
Save Setup

The oscilloscope software saves the current setup before you close the oscilloscope
software. The oscilloscope recalls this setup the next time you run the software. You can
use the “Save Setup” menu to permanently save up to several different setups.

Load Setup

The oscilloscope can recall the last setup before the oscilloscope software was running,
any saved setups, or the factory setup. You can use the “Load Setup” menu to
permanently recall a setup.

Factory Setup

The oscilloscope software is set up for normal operation when it is shipped from the factory.
This is the factory setup. To recall this setup, push the “Factory Setup” menu.
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3.2 Set Vertical System

Set Channel
Click “Vertical” in “Setup” menu.

The Channel Selection

Zelect Channel

SN~

The Channel Control Panel in sidebar
“ertical

CH1 v OMIOFF

1.000% —
AT A
*1 b

The Vertical function:

Turn ON/Off: Turn on/off the channel
Volt/DIV: Select the channel voltage/div
Coupling: Select the channel coupling
Probe: Select the channel probe attenuation
Invert: Turn on/off the invert function.

Change Volt/DIV

You can click “volt/Div” in” vertical Setup” window to select the voltage

WOLTS (D (1008 2

w

You can also change the selected channel voltage in sidebar
Yettical

CH1 ~ CMASFF

2 00 [
AC w
%1 b d

You can left click and drag the mouse on the knob to change the voltage.
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Set Channel Coupling
Click “Coupling” in “Vertical Setup” window

Coupling | AC R

In the sidebar, you can change the channel coupling too.

Yertical

CH1 w OMAOFF

2oy o
(-
#1 b

You can set the coupling to DC, AC or GND. If you set the coupling to DC, it blocks the AC
component of the input signal.

Probe Attenuation Setting

Select the attenuation factor for the probe. To check the probe attenuation setting, toggle
the probe menu to match the attenuation factor of the probe.

This setting remains in effect before you changed again.
Click “Probe” in Vertical Setup window to select the probe attenuation
Probe | x1 w

The probe setting window in the sidebar

Wertical

CHA w OMADFF

2.00% —
AC w
A

Note: The attenuation factor changes the vertical scale of the oscilloscope so that the
measurement results refect the actual voltage levels at the probe tip.
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Set Math

Click “MATH?” in Channel menu to set MATH channel.
The MATH Setup window:

NATH Setup §|
=etting
[ ] CmioFF
Operste
Source & [CH1 w
=8+ B
Source B [CH2 hd
{::- A-B
YWOLTS SO |4 .00y W ke B
AT B
QO FFT

|:| Irrvert

Cancel

ON/OFF: Turn On/Off the MATH Channel.

Source A/B: Set the sources of the math channel.

Operate: Set operates type of the math channel.

Volt/DIV: Set the resolution of the math channel.

Probe: Set the math channel probe attenuation.

Invert: Turn on/off the invert function

The mathematic functions include addition, subtract, multiply and FFT for CH2.

Source A/B

Source A and Source B Menu

Source & [ CH1 A

Source B [CH2 b

Operate

Four Types:

A+B Add source A and source B

A-B Subtract source B from source A

AXxB Multiply source A by source B

A/B Divide source A by source B

FFT Convert a time-domain signal into its frequency components (spectrum).

USER'S MANUAL 33



Hantek 6000BC/Hantek 6000BD/Hantek 6000BE
Digital Oscilloscope

In this function, use the addition, subtraction, multiplication and FFT function to operate
and analyze the waveform.

Select the operate type in the Operate menu. Select source A and B. Then adjust the
vertical scale and offset to view the math channel clearly. The mathematic result can be
measured by the measure and the cursor.

The Math Function Display
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Invert

The invert function turns the displayed waveform 180 degrees, with respect to the ground
level. When the oscilloscope is triggered on the inverted signal, the trigger is also inverted.

Click “Invert” in MATH.

[ Tirevert
The following picture shows the waveform before inversion:
TrigD N 1 ks 000y

fe=E - .00 Time: 50.00us

The following picture shows the waveform of inversion:
Trig'D § 0.00uY

W=~ 100 Tirme: 50.00us
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Set Reference

Click “REF” in “Setup” menu to set REF channel.

EEF 5Setup
Setting

[ OMioFF

ot £ DI Time (Dl | 50.00us
Drag

Fef DataLen: O Mowve Step 1000
|= | =< 0 =a =|

3

The Reference Channel Function:

On/Off: Turn on/off the reference channel.

Volt/DIV: Channel the resolution of the reference channel.

Load: Load the reference waveform from the “.rfc” file from your computer.
Save: Save the current reference waveform to your computer as “.rfc” format.
Save Reference: Save the current reference waveform to your computer as “rfc” format.
You can change the vertical scale of a waveform. The waveform display will contract or

expand relative to the reference level.

Load

Click “Load” to load the “*.rfc” file that was selected. The load file window will appear.

Save

Click “Save” to save the waveform to *.rfc file. The saved source window appears.

Save r5_<|

Zelect 5 channel

The save file window will appear after you selected the saved source.
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The Reference Waveform Display Window:

f 0.00u

Time: 500.0us

Note: If you turn on the “Reference” channel, the load file window will appear.

3.3 Setup Horizontal System

Change Time/Div
The “Time/Div”

Time [ DI [S0.00us W

Selects the horizontal Time/DIV (scale factor) for the main or the window time base
The Horizontal Panel

Harizontal

Time & DI
S000us W
Format

¥-T b

Click the blue knob can change Time/Div.

If the waveform acquisition is stopped, Time/Div control expands or compresses the
waveform.

Change Format

Click “Time/Div” you can set the Time base in Horizontal Setup window.
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Time [ DY [S0.00us W

In the “Format” item, set the waveform display format (Y-T, X-Y).
Y -T: Show the relative relation between vertical voltage and horizontal time
X -Y: Show CH1 value at X axis; CH2 value at Y axis

Change Horizontal Position

Double click the channel button to set the trigger point to the horizontal center of the
screen.

Horizontal position changes the displayed waveform position, relative to the trigger point.

The user can drag LA on screen to change the horizontal position.
3.4 Set Trigger System

Click “Setup->Trigger”, you can configure the trigger.
The user can also click I-i in the toolbar to set Trigger.

1. Set Trigger
Trigger Setup Lo

Setting

Trigger Mode | Edge -

Trigger Sweep | AUTO -

Trigger Source |CH1 -

Al

Trigger Slope |+

HF Rejection

Edge Trigger

The trigger determines when the oscilloscope starts to acquire data and display a wave-
form. When a trigger is set up properly, it can convert unstable displays or blank screens
into meaningful waveforms. If the oscilloscope wants to acquire a waveform, it collects
enough data so that it can draw the waveform to the left of the trigger point. The
oscilloscope continues to acquire data while waiting for the trigger condition to occur. The
oscilloscope continues to acquire enough data so that it can draw the waveform to the
right of the trigger point after it detects a trigger.

The Edge trigger determines whether the oscilloscope finds the trigger point on the rising
or the falling edge of a signal. Select Edge trigger mode to trigger on Rising edge or
Falling edge.
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Mode: Select the trigger mode.

Trigger Mode = L

Sweep: Set the sweep mode to Auto, Normal or Single.

Tiger Sweet v

Auto: Acquire waveform even no trigger occurred
Normal: Acquire waveform when trigger occurred.
Single: Acquire waveform when trigger occurred then stop

Source: You can use the trigger source options to select the signal that the oscilloscope

uses as a trigger. The source can be any signal connected to a channel BNC.

Trigger =ource HoHA W

CHL1: Select CHL1 as trigger signal
CH2: Select CH2 as trigger signal
CH3: Select CH2 as trigger signal
CH4: Select CH2 as trigger signal

Slope: Set the slope to Rising (+) or Falling (-).

Rising: Trigger on rising edge
Falling: Trigger on falling edge

The user can also change the trigger setting on trigger panel in sidebar.

Triciger

Trigger Mode | Edge w
Trigger Sweep | AUTO W
Trigger Zource  |CH1 w

Trigger Slope

Set Pulse Trigger

Pulse trigger occurs according to the width of pulse. The abnormal signals can be
detected through setting up the pulse width condition.

Trigger Mode
Mode:
Trigger Sweep v
Sweep:
Trigger Source HoHA1 W
Source:
PW Condition:
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Pulse Width: The Pulse Width adjust range is 10ns~10s. When the condition is met, it will
trigger and acquire the waveform.

Pulse Width Setting X

Setting

Time Unitz | ns W

| ok | ’ Cancel ]

The user can also change the trigger setting on trigger panel in sidebar.

Trigger

Trigger Mode | Pulse b
Trigger Sweep | AUTO A
Trigger =ource | CH1 b

P Condition |+ Less W
Pulse Wickth

When alternative trigger is on, the trigger sources come from two vertical channels. This
mode can be used to observe two non-related signals. You can choose two different trigger
modes for the four vertical channels.

Options Settings | Comments
With Pulse highlighted, the trigger occurs on pulses that
Pulse meet the trigger condition (defined by the Source, When
and Set Pulse Width options).
Auto, Auto: Acquire waveform even no trigger occurred
Sweep Normal, Normal: Acquire waveform when trigger occurred
Single Single: Acquire waveform when trigger occurred then stop.
CH1
CH2 : : .
Source CH3 Select the input source as the trigger signal.
CH4
+Less, +Less: +Pulse width less than selecting pulse condition.
+Equal, +Equal: +Pulse width equal than selecting pulse condition.
PW +More +More: +Pulse width more than selecting pulse condition.
Condition -Less -Less: -Pulse width less than selecting pulse condition.
-Equal -Equal: -Pulse width equal than selecting pulse condition.
-More -More: -Pulse width more than selecting pulse condition.
Pulse Width Set Puls_e Width highlighted, including Time Unit and
Pulse Width

Video Trigger:
Mode: Select the trigger mode.

Trigger Mode \ideo
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Sweep:
Trigiger Swweep ALUTO -

Source: Setthe Trigger Channel to CH1,CH2,CH3,CH4.

Trigger Channel | CHA b

Trigger Sync:

Trigger Sync Al Line= b

Trigger Standard:

Standard PALSES R
Options Settings Comments
With Video highlighted, an NTSC, PAL or SECAM
Video standard video signal will be triggered. The trigger
coupling is preset to AC.
A Auto: Acquire waveform even no trigger occurred
uto, ) : .
Normal: Acquire waveform when trigger occurred
Sweep Normal Sinale: Acaui f hen tri d th
single ingle: Acquire waveform when trigger occurre en
stop.
CH1
CH2 : . .
Source CH3 Select the input source as the trigger signal.
CH4
All Lines
Line Number | Choose a proper video sync. When selecting Line
Sync Odd Field Number for the Sync option, you may use the User
Even Field Select knob to specify a line number.
All Fields
Standard NTSC Choose a video standard for sync and line number
PAL/SECAM | count.
Set ALT System

Mode: Select the trigger mode.

Trigger Mode ALT b d

Trigger Channel: Set the Trigger Channel to CH1,CH2,CH3,CH4.

Trigger Channel | CHA w

Trigger Type: Set the Trigger Type to Edge or Pulse.

Triger Type

PW Condition: Set the PW Condition to the following condition.

+More: +Pulse width more than selecting pulse condition.

+Less: +Pulse width less than selecting pulse condition.
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+Equal: +Pulse width equal to selecting pulse condition.
-More: -Pulse width more than selecting pulse condition.
-Less: -Pulse width less than selecting pulse condition.
-Equal: -Pulse width equal to selecting pulse condition.
Pulse Width: The Pulse Width adjust range is 10ns~10s. When the condition is met, it will

trigger and acquire the waveform.

Pulse Width Setting [X]

Setting

Time Unitz |ns w

The user can also change the trigger setting on trigger panel in sidebar.

Trigger
Trigger Mode | ALT b
Trigger Channel | ZH1 b
Trigger Type  |Pulze W

Py Condition |+ Less W

Pulze Wicth 10.0n=

High Frequency Rejection

Select “HF Rejection” in “Trigger Setup” window
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Trigger Setup ||

Setting

Trigger Mode | Edge -

Trigger Sweep | AUTO -

Trigger Source [ CH1 -

Trigger Slope |+

HF Rejection

The user can turn on “HF Rejection” to eliminate trigger higher-frequency (20M above)

3.5 Save/Load

Save

Click “File” in main menu to save waveform, setups and screen.

‘I.I’iew Setup Display Cur

Mew Cirl+MN
Close

Load Data Ctrl+L
Load Setup

Save Data Ctrl+5
Save Setup

Save Image

Print... Ctrl+P
Print Preview

Print Option

Exit

1. Save Data
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Save waveform data as a type file
2. Save Setup

Save the current oscilloscope setup to file

3. Save Image

Save the software display window as a .bmp or .jpg file

Load

Click “File” in main menu to recall saved waveform, setup

1. Load Data
Load the waveform that had saved as a type file
2. Load Setup

Load the instrument that had saved

3.6 Utility Function

3.6.1 Record

The following picture shows the Record Interface. The dialog box of record is shown on the
lower right corner of the screen.

Recorder
Path: Cidatadre [
@ Storage Play Back

Interval(S) Fastest
Start Stop

This function can record input waveform form CH1, CH2, CH3, CH4.
Storage: Record waveform and save it as “.dfr” file. “Play Back” button: Click this button

to start playing back waveform.
“Start” button: Start to record waveforms. After you start to record waveforms, this window

will disappear. Please click “Utility->Record” to open the window again. Click “Stop” to stop
recording waveforms.

Recorder
Path: Cdatadre [
@ Storage Play Back

Intervalis) Fastest

Start Stop
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Recorder
Path : |C:idata.drc

(@ Storage Play Back

Interval(S) Fastest

File Information:

Writing: Recording data.

Reading: Playing back data.

data.0.drf: the name of the recorded file. The Max. length of this file is about 1GB. When
recording data length is more than 1GB, it will create next file named data.1.drf, and so on.

When click play back button, it will play back data from the first file (data.0.drf) to the last
file. If you want to read an arbitrary file, please delete the data.drf, and then play back.

3.6.2 Pass/Falil

Click “Pass/Fail” in “Utility” menu.

Record

Fass/Fail

F/C r

Calibration
Factory Setup

Language L

The Pass/Fail window appears:

X]

Paz=/Fail

Control Mask

OMICFF : -
A verticsl [N | o

Source

Horizortal [N | o
Output | AR LT

[ Stop wwhen Output

Operste

The Pass/Fail function monitors changes of signals and outputs pass or fail signals by
comparing the input signal with the pre-created mask.

Control Setting
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Control
[ ] omMssFF

Source

v

[]=top when Output

Source: Select the Pass/Fail channel

Source CHA1 w

Output: Select the Pass/Fail output condition.

Output | FalL v

Stop When Output: If it was checked, the Pass/Fail will stop when output.

[ ] Stop wahen Sutput

Mask Setting
M=k

“ertical 0.04 el
Horizortsl  SEERIEEE = | oy

Vertical: Set the vertical limit range

Vertical “ Dlv

Horizontal: Set the horizontal limit range

Harizantal 004 (el

“Create” button: Click this button to create Pass/Fail area according to the mask

Creste

“Save” button: Click this button to save the setups to file

Save

“Load” button: Click this button to load the saved setups file

Load

Information Display
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Fail: It shows the fail waveform number
Pass: It shows the pass waveform number

Total: It shows the | total Pass/Fail waveform number

Operation
Operate

Start

Click “Start” button to start the Pass/Fail test.
Click “Stop” button to stop the Pass/Fail test.

The Pass/Fail function display
Trig'D ¥ 0.00uv

Mol Qwfs

ogh] -~ 1.00V Time: 40.00us

NOTE: Pass/Fall function is unavailable in X-Y mode.
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3.6.3 Factory Setup

Click “Factory Setup” in “Utility” menu to load default setups

mm Yehicle W:

Record
Fass/Fail

F/C r

Factory Setup

Language L4

When you click the Factory Setup in Utility menu, the oscilloscope displays the CH1
and CH2 waveforms and removes all other waveforms.

The oscilloscope set up for normal operation when it is shipped from the factory and can be
recalled at anytime by user.

The Factory Setup function does not reset the following settings:

m Language option
m Date and time

3.6.4 Language
Click “Language” in “Utility” menu

Record
Fass/Fail

F/C k

Calibration

Factory Setup

Language Default English
eI
v Engzlish
Deut=ch

There are four languages in “Language” menu. The default language is English.
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3.7 Measure Signal

3.7.1 Cursor Menu

Click “Cursor” in main menu.

Mea=
Source F

Type r

This method allows you to take measurements by moving the cursors

1. Source

Cursor | Measure Acquire Utility Veh

Source b ¥ | CH1

Type ] CH2
CH3
CH4
MATH

The user can set the source to CH1, CH2, CH3, CH4 and MATH.
When you use cursors, be sure to set the Source to the waveform on the display that
you want to measure.

2. Type

A Meas

Source M

Cross

Trace
Vertical
Horizontal

There are four types of cursors: Cross, Trace, Vertical and Horizontal
1) Cross

The Cross cursors appear as cross lines on the display and measure the vertical and
horizontal parameters.
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The Cross cursor display window:
TrigD (] $EE 000wy

(o=l - 1.00% Tirme: 50.00us

The Cross measure result displays on status bar
Freq: 1. 03ZKHz Time: 969uS Volt: S0SmY
2) Trace

The Trace cursors appear as vertical lines on the display and measure the waveform
amplitude at the point the waveform crosses the cursor.

The Trace cursor display window
TH'D i ’ I 4 & ooow

(o=l . 1.00% Time: 50.00us

The Trace cursor measure result display on status bar

¥olt: —-1.95V

3) Vertical
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The Vertical cursors appear as vertical lines on the display and measure the vertical
parameters.

The Vertical cursor display window:

TrigD i 4§ EE o.oouv

(o=l - 1.00% Time: 50.00us

The Vertical cursor measure result display on status bar

Freq: 820. 1Hz Time: 1.22m=

4)Horizontal

The Horizontal cursors appear as horizontal lines on the display and measure the
horizontal parameters.

The Horizontal cursor display window:

TrigD (] $EE 000wy

(o=l - 1 .00% Tirme: 50.00us

The Horizontal cursor measure result display on status bar
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¥olt: -3.01¥

3.7.2 Measure Menu
Click “Measure” in main menu.

The oscilloscope provides 20 parametric auto measurements (12 voltage and 8 time

measurements).
Source »
Vertical »
Horizomtal r

Clear Measure

Edit Measure

1.Source

Measure | Acquire Utility WVehicle Window
Source | ¥ | CH1
Vertical > CH2
Horizontal » CH3
Clear Measure CH4
Edit Options -

The user can use the “Source” menu to select a measure source.

2. Vertical
Source L4
Vertical M az1mum
Horizontal + Minimum
Clear Measure Fealt to Peak
Edit Measure
Top
Base
Middle
EMS
Amplitude
Mean
Cycle Mean

Fositiwe Owershoot

Hegatiwe Owvershoot

Maximum: Voltage of the absolute maximum level, Measured over the entire waveform
Minimum: Voltage of the absolute minimum level, Measured over the entire waveform
Peak To Peak: Peak-to-peak = Max —Min, Measured over the entire waveform

Top: Voltage of the statistical maximum level, Measured over the entire waveform
Base: Voltage of the statistical minimum level, Measured over the entire waveform
Middle: Voltage of the 50% level from base to top

USER'S MANUAL 52



Hantek 6000BC/Hantek 6000BD/Hantek 6000BE
Digital Oscilloscope

RMS: The Root Mean Square voltage over the entire waveform

Amplitude: Amp = Base - Top, Measured over the entire waveform

Mean: The arithmetic mean over the entire waveform

Cycle Mean: The arithmetic mean over the first cycle in the waveform

Preshoot: Positive Overshoot = (Max - Top)/Amp x 100 %, Measured over the entire
waveform

Overshoot: Negative Overshoot = (Base - Min)/Amp x 100 %, Measured over the entire
waveform.

3.Horizontal
=

Source *

Vertical L4
Feriod

Clear Measure Frequency

Edit Measure ) )
Rize Time
Fall Time

+ Duty Cyele
= Duty Cyele

+ Ful=ze Width
- Pul=ze Width

Period: Time to take for the first signal cycle to complete in the waveform

Frequency: Reciprocal of the period of the first cycle to complete in the waveform

Rise Time: Time taken from lower threshold to upper threshold

Fall Time: Time taken from upper threshold to lower threshold

+Duty Cycle: Positive Duty Cycle = (Positive Pulse Width)/Period x 100%, Measured of the
first cycle in waveform.

-Duty Cycle: Negative Duty Cycle = (Negative Pulse Width)/Period x 100%, Measured of
the first waveform.

+Pulse Width: Measured of the first positive pulse in the waveform. The time between the
50% amplitude points

-Pulse Width: Measured of the first negative pulse in the waveform. The time between the

50% amplitude points

4. Clear Measure
Clear all measure items on display screen.

The Measure Display Window:
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TriyD - 1 0.00u¥

3681174

I H 1 i Tirme: 500.0us

Note: The results of the automatic measurements will be displayed on the bottom of the
screen. Maximum 8 results could be displayed at the same time. When there is no room,
the next new measurement result will make the previous results moving left, out of screen.

5. Edit Measure

Click “Measure->Edit Measure”.

Neazure Nenm ii

Meszure Options

(®)CHY O cH2 [Llndcu Al ] | Close |

Hotizontal Measure

|:| Maximum |:| Top |:| RS |:| Mean
|:| hinimurn |:| Miciclle |:| Amplitude |:| Cycle Mean
|:| Peak to Peak |:| Base |:| Positive Overshoot |:| Megative Overshoot

Serical Meazure

|:| Period |:| Rize Time |:| + Dty Cycle |:| + Pulze Width

|:| Frequency |:| Fall Time |:| - Dty Cycle |:| - Pulze Width

User can select Maximum 8 measure options to measure.

3.8 The Display System

3.8.1 Display Type

Click “Type” in “Display” menu.
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The following figure shows the type parameters setting.

Display
v Grid Ctrltiz Dots
Inten=sity

Logie Chanmel

If the Vectors type mode is selected, the waveform will be displayed as following figure.

Trig'D ¥ 0.00uY

CH | R Tirne: 500.0us

If the Dots type mode is selected, the waveform will be displayed as following figure.
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TrHgD

= H1

3.8.2 Display Grid

Click “Display” in main menu

Display

Type »
Ctrlti

Inten=sity
Logie Chanmel

The grid shows:

TrHyD

= . 1.00

USER'S MANUAL
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The grid not shows:
Trig'D T : 4 0.00uy

gh] - 1.00v Tirme: a00.0us

3.8.3 Intensity

Click “Display->Intensity” in main menu.

The following figure shows the intensity dialog. It shows the display parameters setting.

Intensity '
Setting

Grid { Scale J

Wigneefarm J

You can change the grid and waveform color intensity in this dialog.
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Trig'D § 0.00uy

CH1 GO Tirne: 500.0us

3.9 Zoom In/Out and Drag Waveforms

The software will stop updating waveform after the user clicked “Stop” button.

The user can change the waveform display by adjusting the scale and position.

When you change the scale, the waveform display will increase or decrease in size.

When you change the position, the waveform will move up, down, right, or left.

The channel reference indicator identifies each waveform on the display. The indicator
points to the reference level of the waveform record.

utility Vehicle Windon
¥ Run Ctrl+R
Stop Ctrl+0

foom Out

foom In

Buffer Length ]
Acquisition b

Interpolation b

Autoset

Zoom In/Out

The user can click “Zoom In/Out” in “Acquire” menu, then left or right click the mouse
button on display screen to zoom in/out the waveform. Also the user can change
Time/Div in Horizontal menu or in Horizontal panel to zoom in/out the waveform.

Drag
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The user can modify the waveform position after clicked “Drag” in “Acquire” menu
following the following steps.

Drag Waveform E|
Operation
CH1 W
Mermary Data Lencgth 102240
Move Step | 1000 |
||q'lq'-4]| 10239 |[:=~:=~][:=~|l

1.Select Channel:

CH1 W

2.Set the Move Step:

Mosve Step | 1000

3.Change the waveform position:

10239 I” ] [ . ]

3.10 Interpolation

At the time base 40ns/div or faster, user can use the 3 different interpolation mode to get
waveforms of different smoothness.

The Step Interpolation:
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The

The Sin(x)/x Interpolation:
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Note: The default interpolation mode is Sin(x)/x.
Acquisition

When you acquire a signal, the oscilloscope converts it into a digital form and displays a
waveform. The acquisition mode defines how the signal is digitized and the time base
setting affects the time span and level of detail in the acquisition.
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3.11 Acquisition Modes

There are two acquisition modes: Normal, Average and Peak Detect.
Utility Vehicle Windo
v  Run Ctrl+R
Stop Ctrl+0

Ffoom Qut

foom In

Buffer Length k
Acquisition k| v Mormal
Interpolation ] Average ]

Autoset Peak Detect

Normal: In this acquisition mode, the oscilloscope samples the signal in evenly spaced
intervals to construct the waveform.

Average: In this acquisition mode, the oscilloscope acquires several waveforms, averages
them, and displays the resulting waveform. You can use this mode to reduce random noise.

Peak Detect: In this acquisition mode, the oscilloscope finds the maximum and the
minimum in every sampling interval, and use these values to show waveform.

3.12 Print And Print Preview

Mew Cirl+MN
Close

Load Data Ctrl+L
Load Setup

Save Data Ctrl+5
Save Setup

Save Image

Print... Ctrl+P
Print Preview

Print Option

Exit
1. Click “Print” in “File” menu to set the printer to print the current waveform
2. Click the “PrintPreview” in “File” menu to get into the Preview window.

In “PrintPreview” window, use the “Zoom In” button and the “Zoom Out” button to
change the size of the waveform graph. Click the “Close” button to turn this window off and
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click the “Print” button to print the report.

The Print report:

Test Report
Hantek 6000B
pate 2 0E201 ne = 11:00:38
NOTE :
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Chapter 4 Application Example

€4 Simple Measurement

€ Capturing a Single-Shot Signal
€ The Application of the X-Y

€ Taking Cursor Measurement

@ Arbitrary Waveform Generator
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4.1 Simple Measurement

To acquire and display a signal, please do the steps as follows:
1. Connect signal to CH1 by using probe
2. Click the button on toolbar or “Acquire -> Auto Setup” on menu.

The DSO set the vertical, horizontal, and triggers controls at the best status automatically.
Also, you can adjust the controls to meet your measurement to optimize the waveform
display.

To measure the frequency and “Vpp”, you can do these steps as follows:

1. Click the “Measure->Horizontal->Frequency” button, the frequency of the signal
display on the bottom of the waveform interface.

2. Click the “Measure->Vertical->Peak-to-Peak” button, the “Vpp” of the signal will also
display on the bottom of the waveform interface.

To clear the measurement on the waveform interface, click the “Measure->Clear
Measure” button.

Trig'D B 0.00uy

ogh] ~ 1.00V Tirme: A0.00us
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4.2 Capturing a Single-Shot Signal

To capture a single event, it needs to gather some pre-test knowledge of the signal in order
to set up the trigger level and slope correctly. For example, if the event is derived from 3.3V
COMS logic, a trigger level of 1.2 or higher Volts should work on a rising edge. Do these
steps as follows:

1. Set the probe and the channel attenuations to X 10.

2. Set up the trigger in the Trigger Menu, or in the Trigger Setting window.
1) Adjust the Trigger Mode to Edge.

2) Set the Trigger Sweep to Single.

3) Set the Trigger Source to CH1.

4) Set the Trigger Slope to “+” which means you select the rising edge.

5) Adjust the Volts/Div and the time base in a proper range for the signal.

6) Drag the trigger level sign on the waveform display screen to proper position. It ally
higher a little above the normal level.

7) Click START button to start capturing. When the trigger conditions are met, data
appears on the display representing the data points that the oscilloscope obtained with one
acquisition.

This function helps to capture the signal occurrence easily, such as the noise with large
amplitude; set the trigger level higher a little above the normal level and press and wait.
When noise occurs, the instrument will record the waveform before and after the trigger.

4.3 The Application of the X-Y Operation

X-Y Plot acts to analyze correlation of data of two channels. Lissajous diagram is displayed
in the screen when you use X-Y Plot, which enables to compare frequencies, amplitudes
and phases of counterpart waveform against the reference waveform. This makes it
possible to compare and analyze frequency, amplitude and phase between input and
output.

Do these steps as follows:

1. Set the probe attenuation to “x10” Set the switch to “x10” on the probes.

2. Connect the CH1 probe to the input of the circuit, and connect the CH2 probe to the
output of the circuit.

3. Click ‘d button.

4. Adjust the vertical scale and offset to display approximately the same amplitude
signals on each channel.

5. Select X-Y format at Horizontal window. The oscilloscope will displays a Lissajous
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pattern representing the input and the output characteristics of the circuit.

6. Adjust the scale and offset of the horizontal and vertical to a desirable waveform
display. The following picture shows a typical example.

7. Apply the Ellipse Method to observe the phase difference between the two channels.

Signal in X-Y Format:

Instruction of the Ellipse Method

Signal must be
centered in X

Sin@ = A/B or C/D, where 8 = phase shift (in degrees) between the two signals.

From the formula above:
8 = arcsine (A/B) or _arcsine (C/D)

8 must be in the range of (0~11/2) or (311/2~2™) if the main axis of the ellipse is between |
and lll quadrant, . If the main axis is at Il and IV quadrant, 6 must be in the range of (11/2~1)
or (TT~311/2).
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4.5 Taking Cursor Measurements

Use cursors to make time and amplitude measurements on a waveform quickly.

Measure the Peak Frequency or Time of the First Sine Waveform

Do these steps:

1

2.

3.

4.
5.

. Click “Cursor->Source”, select CH1 (select CH2 if you want measure CH2).
Click “Cursor->Type”, select Vertical.

Push left mouse button, and the vertical lines appear.

Drag the mouse button to the point you want to measure.

Release the left mouse button, the frequency difference and time difference will be

shown at the status bar.

Measure the Frequency and Time:

THyD ¥ 0.00uY

CH 1 EER Tirne: 50.000s

Read the details showing in the status bar.

Freq: 1.361FKHz Time: T35uS

Measure the Amplitude of the First Waveform Peak of the Waveform

Do these steps:

1

2

U

. Click “Cursor->Source”, select CH1 (select CH2 if you want measure CH2).

. Click “Cursor->Type”, select Horizontal.
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3. Push left mouse button, and the Horizontal lines appear.
4. Drag the mouse button to the point you want to measure.

5. Release the left mouse button, the voltage difference will be shown at the status bar.

Measure the Amplitude:
Trig'D ¥ 0.000

CH 1 G Tirne: 50.00us

Read the details showing in the status bar.

¥olt: 15.6Y

Trace the Amplitude of a fixed position on X-axis in a Waveform

Do these steps:

1. Click “Cursor->Source”, select CH1 (select CH2 if you want trace CH2).
2. Click “Cursor->Type”, select Trace.

3. Click the cursor at the position that you want traced of the wave in the waveform
window.
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Trace the Amplitude:
Trig'Ds s 0,000y

BRE] - 1.00% Time: 50.00us
Read the details showing in the status bar.
Volt: -9 45V

Note: Click “Cursor->Type”, select “Cross”, you can measure time and amplitude at

one time.
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4.7 Waveform Generator

Caution: This part is only used for HANTEK 6000BD.

DSO 3062AL can also be used as the Arbitrary Waveform Generator, with one channel of
arbitrary waveform output, 8 Bits output, synchronized signal out puts. User can edit the
waveform arbitrary by the mouse or choose the regular waveforms such as Sine, Square,
AM/FM, Ramp, Trapezia, Gause, Arb, Exponent, White.

Select the DDS control panel in the sidebar.

pso | DDS

[(Jonio [syne []Single
Wigve Type

) Sine () Souare () AMFM
D Rarmp {:} Trapezia {:} Gause
{:} Ark {:}Expunent{:} White

Parameter

Frequency

Hz (0 ~ 7SMHzZ)

Amplitude

2.000 W0~ 3.5
Y Offset
Phaze

Click any button of certain waveform to switch to the output of such kinds of waveform.

The user can select wave type as below:
Wigve Type

(%) sine () Sguare () AMFM
{:} Ramp {:} Trapezia {:}' Gausze

{:} Arb {:}Expnnem{:} vwhite
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Waveform Parameter Setup
Select a wave type, and you can set the “Parameters” in the sidebar.
Generate the Sine waveform

To output a Sine Wave, please do the following steps:
1. Press the check box "On/Off" to open the wave output function.
2. Select the Wave Type "Sine Wave".
3. Set the Wave Parameter:
Frequency: Set the output wave frequency.
Sweep: Set the output wave to sweep.
Amplitude: Set the output wave amplitude.
Y Offset: Set the output wave vertical level offset.
Phase: Set the output wave phase.
The Sine waveform window as the following:

Farameter

Freguency

Hz (0 ~ 75MHz)

Amplitude

2.000 Yo~ 35V
Y Offset
Phaze

Generate the Square waveform

To output a Square Wave, please do the following Step:
1. Press the check box "On/Off" to open the wave output function.
2. Select the Wave Type "Square".
3. Set the Wave Parameters:
Frequency: Set the output wave frequency.
Amplitude: Set the output wave amplitude.
Y Offset: Set the output wave vertical level offset.
Phase: Set the output wave phase.
Duty: Set the duty of the output wave.
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The Square waveform window as the following:

Parameter

Freguency

Hz (0 ~ 75MHz)

Yo~ 35

WOT e TV

(00~1.0

(0.0~1.0)

Generate the AM/FM waveform

To output an AM/FM Wave, please do the following Steps:
1. Press the check box "On/Off* to open the wave output function.
2. Select the Wave Type "AM/FM".
3. Set the Wave Parameters:
Frequency: Set the output wave frequency.
Amplitude: Set the output wave amplitude.
Y Offset: Set the output wave vertical level offset.
Phase: Set the output wave phase.
High Frequency: Set the output wave Hight Frequency.
Depth: Set the output wave Depth.
Max Frequency: Set the output wave Max Frequency.
FM: Change the output wave "AM" into "FM".

The AM/FM waveform window as following:

Farameter

Freguency

Hz (0 ~ 75MHz)

WPk to PK) - 4000

W (0~ 35%)
VO[T~ TV

(00~1.0

Depth

Hz ((ER=NN]

Hz []Fn
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Generate the Ramp waveform

To output a Ramp Wave, please do the following steps:
1. Press the check box "On/Off" to open the wave output function.
2. Select the Wave Type "Ramp".
3. Set the Wave Parameters:
Frequency: Set the output wave frequency.
Amplitude: Set the output wave amplitude.
Y Offset: Set the output wave vertical level offset.
Phase: Set the output wave phase.
Duty: The duty of the output wave.

The Ramp waveform window as the following:

Parameter

W(Pk to Pk) - 4000 Y

Freguency

Hz (0 ~ 75MHz)

2.000 Yo~ 354 )

WO(T TV

{0.0~1.0)

(00~1.0

Generate the Trapezia waveform

To output a Trapezia wave, please do the following steps:
1. Press the check box "On/Off" to open the wave output function.
2. Select the Wave Type "Trapezia".

Frequency: Set the output wave frequency.

Amplitude: Set the output wave amplitude.

Y Offset: Set output wave vertical level offset.

Phase: Set the output wave phase.

Duty: Set the output wave duty.

Rise Duty: Set the output wave rise duty.

High Duty: Set the output wave high duty.

Fall Duty: Set the output wave fall duty.
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The Trapezia waveform window as the following:

)+ 4.000 Y

Parameter

Frequency

Amplitucde

2000 Yo~ 354

W Offzet

Phasze
Dty

{0.0~1.0)

Generate the Gause waveform

To output a Gause Wave, please do the following steps:
1. Press the check box "On/Off* to open the wave output function.
2. Select the Wave Type "Gause".
3. Set the Wave Paramters:
Amplitude: Set the output wave amplitude.

The Gause waveform window as the following:

Parameter

Ll | " | | ol

Amplitude

Yo(0~ 35 )

Generate the Arb. waveform

To output an Arbitrary Waveform, please do the following steps:
1. Press the check box "On/Off" to open the wave output function.
2. Select the Wave Type "Arb.".
3. Set the Wave Parameters:

Freguency: Set the output wave frequency.
4. Set the output wave.

The Arb. waveform window as the following:
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Parameter

Frequency

Generate the Exponent waveform

To output an Exponent Waveform, please do the following steps:
1. Press the check box "On/Off" to open the wave output function.
2. Select the Wave Type "Exponent".
3. Set the Wave Parameters:

Frequency: Set the output wave frequency.

Amplitude: Set the output wave amplitude.

Y Offset: Set the output wave vertical level offset.

Phase: Set the output wave phase.

Tao: Set the ouput wave Tao param.

Rise: Set the output wave slope.

The Exponent waveform window as the following

Parameter

Freqguency

Hz (0 ~ 75MHz)

Amplitude
2000 W0~ 3.5
W Offzet
Phase
Tao Rize

0.001 =

Generate the White noise waveform

To Generate a White noise Wave, please do the following steps:
1. Press the check box "On/Off" to open the wave output function.
2. Select the Wave Type "White".
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3. Set the Wave Parameters:
Amplitude: Set the output wave amplitude.

The White noise waveform window as the following:

=

Mr H M ﬂ

bl
| ‘N J'l‘ M

Parameter

i

Amplitude

Yo(0~35%)
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Chapter 5 Appendix

€ Appendix A: Specifications

€ Appendix B: General Maintenance
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Appendix A: Specifications

Specifications Table:

Vertical

Analog Channels

4

Bandwidth

250/200/100/70MHz(-3dB)

Input Impedance

Resistance: 1MQ ; Capacitance: 25 pF+3pF

Input Sensitivity

2mV/div to 10V/div

Input Coupling

AC/DC/GND

Vertical Resolution

8 bits

Memory Depth

64K/CH,32K/2CH,16K/4CH,

Maximum Input Protection

400V (DC+AC Peak)

Horizontal

Real-Time
Sampling Rate

1GS/s

Time Base Range

2ns/div to 1000s/div(1-2-5 sequences)

Time Base Precision +50ppm

Trigger

Source CH1, CH2, CH3, CH4

Mode Edge, Pulse, Video, Alternative
X-Y mode

X-Axis Input CH1

Y-Axis Input CH2

Phrase Shift

Max.3 degree

Cursors and Measuremen

t

Voltage Measurement

Vpp, Vamp, Vmax, Vmin, Vtop, Vmid, Vbase, Vavg,
Vrms, Vcrms, Preshoot, Overshoot

Time Measurement

Frequency, Period, Rise Time, Fall Time, Positive Width,
Negative Width, Duty Cycle

Cursors Measurement

Horizontal ,Vertical, Track, Auto Measure Modes

Waveform Signal Process

+,-, X,+, FFT, Invert

Voltage Range

10mV to 10V/div @ x 1 probe

100mV to 100V/div @ x 10 probe

1V to 1000V/div @ x 100 probe

10V to 10000V/div @ x 1000 probe

100V to 100000V/div @ x 10000 probe

Arbitrary Waveform Generator Mode(HANTEK 6000BD)

Waveform Frequency

DC~25MHz

DAC

2K~200MHz adjustable
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Frequency Resolution 0.10%

Channel 1CH waveform output

Waveform Depth 2KSa

Vertical Resolution 12 bit

Frequency Stability <30ppm

Wave Amplitude +3.5V Max.

Output Impedance 50 Q

Output Current 50mA, Ipeak=50mA

System BW 25M

Harmonic Distortion -50dBc(1KHz), -40dBc(10KHz)

Others

Current Range CC65(20A),CC65(60A),CC650,CC1100
Cursor Time/frequency difference, voltage difference
FFT Rectangular, Hanning, Hamming, Blackman Window
MATH Addition, subtraction, multiplication, division
AUTOSET Yes(=30Hz)

Interface USB 2.0

Power Source Dual port USB

Volume 175 x 105 x 30 (mm)

Weight 1Kg
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Appendix B: Accessories

-

X1, X10 two passive probes. The passive probes have a 6MHz
bandwidth (rated 100Vrms CAT Ill) when the switch is in the X1
position, and a maximum bandwidth (rated 300Vrms CAT II)
when the switch is in the X10 position. Each probe consists of all
necessary fittings.

A USB line, used to connect external devices with USB interface
like a printer or to establish communications between PC and
the oscilloscope.

A PROBE (HANTEK 6000BD)

A software installation CD and it contains the user manual for
the oscilloscopes.
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Appendix C: General Maintenance

General Care
Do not store or leave the oscilloscope where the device will be exposed to direct sunlight
for long periods of time.

Caution

To avoid damages to the device or probes, do not expose them to sprays, liquids or
solvents.

To avoid damages to the surface of the device or probes not use any abrasive or chemical
cleaning agents.

Cleaning

Inspect the device and probes as often as operating conditions require. Make sure the
device disconnect form all power sources.

To clean the exterior surface, perform the following steps:

1. Remove loose dust on the outside of the oscilloscope and probes with a lint-free cloth.
Use care to avoid scratching the clear glass display filter.

2. Use a soft cloth dampened with water to clean the device.
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